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Integrating Microchip’s LAN9252 SDK

 with Beckhoff’s EtherCAT® SSC
INTRODUCTION

The Microchip LAN9252 is a 2/3-port EtherCAT® Slave Controller (ESC) with dual integrated Ethernet PHYs. The 
LAN9252 is typically implemented in Industrial Automation solutions and includes the following main features: 

• Integrated high-performance 100Mbps Ethernet transceivers

• 3 FMMUs, 4 SyncManagers, Distributed clock support, 4K bytes of DPRAM

• 8/16-bit host bus interface allowing connection to most 8/16/32-bit embedded controllers

• SPI / SQI slave interface

• Support for 5 different main configurations:

- Digital I/O (DIGIO)

- HBI

- SPI with GPIO

- SPI with MII - 3-port (MII upstream) mode

- SPI with MII - 3-port (MII downstream) mode

• 3rd port for flexible network configurations

• Comprehensive power management features

• Low pin count and small package size

The purpose of this document is to explain how to integrate the LAN9252 SDK with Beckhoff’s EtherCAT Slave Stack 
Code (SSC) for use with the EVB-LAN9252-HBI evaluation board. Once the SSC is integrated with the SDK, application 
code (depending on the required application) can be added to the SDK to design the EtherCAT slave device. 

Writing application code is not within the scope of this document. To utilize the LAN9252 SDK, one must be a member 
of EtherCAT Technology Group (ETG) to gain access to the Beckhoff SSC. The current SDK is designed to work with 
the Microchip PIC32MX and PIC24 MCU. However, support can be extended to other SOCs.

References

• Microchip LAN9252 Data Sheet

• Microchip EVB-LAN9252-HBI Evaluation Board User’s Guide

• Microchip PIC32MX Data Sheet

• Microchip LAN9252 EEPROM Configuration and Programming
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System Requirements

HARDWARE REQUIREMENTS

• Microchip EVB-LAN9252-HBI Evaluation Board

• Microchip PICkit 3 In-Circuit Debugger/Programmer

• Windows Host Machine with minimum of 2GB RAM

SOFTWARE REQUIREMENTS

• Microchip MPLAB IDE v2.20 or higher

• Microchip MPLAB XC Compiler v1.33 or higher

• Beckhoff EtherCAT Slave Stack Code version 5.10

• Latest version of Microchip LAN9252 SDK

Terms and Abbreviations

TABLE 1:

Term Definition

ESC EtherCAT Slave Controller

ETG EtherCAT Technology Group

EVB Evaluation Board

HBI Host Bus Interface

IDE Integrated Development Environment

SDK Software Development Kit

SPI Serial Protocol Interface

SSC Slave Stack Code

TERMS AND ABBREVIATIONS

PIC32 SOC FIRMWARE FRAMEWORK

FIGURE 1: PIC32 SOC FIRMWARE FRAMEWORK
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SDK DIRECTORY STRUCTURE

This section provides a high-level overview of the contents of the EVB-LAN9252 SDK. The main EVB-LAN9252-
HBI_PIC32_SDK_V1.3 folder contains the following items, as displayed in Figure 2:

• ESI Files - This folder contains ESI files for the different configurations supported by the evaluation board.

• SSC - This folder contains two MPLABX project folders, one for the SPI interface and one for the HBI interface.

• Microchip EVB-LAN9252-HBI-SSC-CONFIG.xml - This is the Slave Stack Code tool configuration file that is 
used to generate ESI files for different configurations supported by the EVB-LAN9252-HBI evaluation board. 

FIGURE 2: LAN9252-PIC32_SDK_V1.3 FOLDER CONTENTS

ESI Files Folder

The ESI Files folder contains EtherCAT slave information files for programming the LAN9252 EEPROM and configuring 
the LAN9252 via an EtherCAT Master tool (such as TwinCAT), as displayed in Figure 3. For detailed information on the 
different configurations of each EtherCAT slave information file in this folder, refer to the ReadMe.txt file located within 
the folder.

FIGURE 3: ESI FILES FOLDER CONTENTS
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SSC Folder

The SSC folder contains the following files/folders, as displayed in Figure 4.

• Common - This folder contains the C source files for the Hardware Abstraction Layer and also the placeholder for 
the Beckhoff Slave Stack Code.

• PIC32 - This is the PIC32 project folder configured for the HBI interface.

• PIC32-SPI - This is the PIC32 project folder configured for the SPI interface.

• ReadMe.txt - This file contains information on the directory structure of the MPLABX folders. 

FIGURE 4: SSC FOLDER CONTENTS

BUILDING A FULL-FEATURED ETHERCAT APPLICATION

Installation

In order to properly use the EVB-LAN9252, users must obtain the Beckhoff EtherCAT Slave Stack Code (SSC). Without 
the SSC, when a Microchip EVB-LAN9252 SDK sample project is loaded into MPLAB, it will result in compilation errors 
and missing source files. This is due to SDK dependencies on generic Beckhoff's slave stack source files. Because of 
this, it is a pre-requisite to integrate Beckhoff’s SSC with the LAN9252 SDK.

The examples in this document use:

• SSC version 5.11

• Configuration file version 1.3.0.0

The steps for building full-featured EtherCAT applications using the SSC are provided below.

1. Download the Microchip EVB-LAN9252 SDK and ensure the following directory structure contains the EtherCAT 
SDK source code:

{SDK_INSTALL_PATH}/EVB-LAN9252-HBI_PIC32_SDK_Vx.x/SSC

2. Download and install the Beckhoff EtherCAT Slave Stack Code (SSC) tool. Download the EtherCAT SSC from 
the following link:

http://www.ethercat.org/login.aspx?ReturnUrl=%2fmemberarea%2fstack_code.aspx

3. To continue the download process, enter the ETG user name and password in the Member Area Login page, as 
displayed in Figure 5.
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Note: You must be an EtherCAT Technology Group (ETG) Member to download the SSC Stack.

FIGURE 5: MEMBER AREA LOGIN

4. If prompted, enter the Vendor ID, and then click Submit Registration, as displayed in Figure 6.

FIGURE 6: VENDOR ID SUBMISSION
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5. Enter the required details, check the “I accept” box, and then click Register, as displayed in Figure 7.

FIGURE 7: SLAVE STACK CODE DOWNLOAD

A download link will be sent to the registered email address.

6. Click the emailed download link to download the EtherCAT Slave Stack Code, as displayed in Figure 8. 

FIGURE 8: SLAVE STACK CODE DOWNLOAD
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7. Extract the downloaded file SSC_V5i11.zip, which contains the directory structure displayed in Figure 9.

FIGURE 9: SLAVE STACK CODE DIRECTORY STRUCTURE

8. Install the EtherCAT Slave Stack Code Tool, accepting the defaults if prompted.

Once installation is complete, ensure the tools displayed in Figure 10 are in the Start menu. 

FIGURE 10: SLAVE STACK CODE TOOLS
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SSC Tool

1. Start the SSC Tool from the Start menu, as displayed in Figure 11.

FIGURE 11: SSC TOOL

2. Click OK to agree to the usage information, as displayed in Figure 12.

FIGURE 12: SSC USAGE INFORMATION

3. From the menu bar of the main screen displayed in Figure 13, click File>New. 

FIGURE 13: SSC TOOL MAIN SCREEN
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4. Click Import to import the SSC Tool configuration file Microchip EVB-LAN9252-HBI-SSC-CONFIG.xml
from the directory {SDK_INSTALL_PATH}/EVB-LAN9252-HBI-PIC32_SDK_Vx.x/ as in Figure 14.

FIGURE 14: SSC TOOL NEW PROJECT

5. After selecting the file, click Open to import the SSC Tool configuration file, as displayed in Figure 15.

FIGURE 15: SSC TOOL NEW PROJECT IMPORT
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6. Once imported, check the “Custom” drop-down box, select the appropriate Microchip configuration, and then 
click OK, as displayed in Figure 16.

Note: The EVB configuration should match the selected configuration in the drop-down box.
 

FIGURE 16: SSC TOOL NEW PROJECT CUSTOM

7. Click Yes in the pop-up window, as displayed in Figure 17.

FIGURE 17: SSC TOOL EXTERNAL FILE CONFIRMATION

An additional pop-up window displays, requesting to add “9252_HW.c”, as displayed in Figure 18.
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8. Click OK. 

FIGURE 18: SSC TOOL 9252_HW.C CONFIRMATION

A file selection dialog displays.

9. Locate the 9252_HW.c file, as displayed in Figure 19.

This is available in the directory:
{SDK_INSTALL_PATH}/EVB-LAN9252-HBI_PIC32_SDK_V1.3/SSC/Common.

FIGURE 19: SSC TOOL 9252_HW.C SELECTION
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Once the 9252_HW.c file has been added, the SSC Tool window displays, as in Figure 20.

FIGURE 20: SSC TOOL NEW PROJECT CREATED

As displayed above in Figure 20, the left panel contains multiple categories where the Slave Stack Code can be 
configured. Refer to the “Help” menu in the tool bar for additional configuration information.

10. From the menu bar, click Project>Create New Slave Files.
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The Create new Slave Files window displays, as in Figure 21.

FIGURE 21: SSC TOOL CREATE NEW SLAVE FILES

11. Click the Start button to create a new Project File, Source Folder, and ESI File in the specified Doc Folder.

A pop-up window displays to indicate that the files have been successfully created, as in Figure 22.

12. Click OK to continue.

FIGURE 22: SSC TOOL FILE CREATION DIALOG
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13. Browse to the directory where the new files were created, as displayed in the example:

- Src (Folder) - This folder contains the Beckhoff Slave Stack code.

- PIC32 EtherCAT Slave (ESP) - This is the SSC Tool project file.

- PIC32 EtherCAT Slave (XML) - This is the EtherCAT slave information file that must be used as an input 
to the EtherCAT master tool to configure EtherCAT slave controllers. 

FIGURE 23: NEW SLAVE FILES

14. Copy all the files from the Src folder to the following directory:
{SDK_INSTALL_PATH}/EVB-LAN9252-HBI_PIC32_SDK_Vx.x/SSC/Common

15. Start MPLAB X IDE, as displayed in Figure 24.
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Note: If MPLAB X IDE has not been installed, it can be obtained from the Microchip website.

FIGURE 24: MPLAB X IDE

16. Click File>Open Project.
 2015-2016 Microchip Technology Inc. DS00001916B-page  15

http://www.microchip.com


AN1916
17. Select the appropriate project: PIC32 (HBI Interface) or PIC32-SPI (SPI Interface), and then click Open. 

FIGURE 25: MPLAB X IDE OPEN PROJECT

After loading the project, the MPLAB X IDE interface should appear as displayed in Figure 26.
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18. Ensure the HAL header file (9252_HW.h) is included in the following C source files:

- 9252_HW.c

- ecatappl.c

- ecatslv.h

- main.c 

FIGURE 26: MPLAB X IDE PROJECT LOADED

19. Select the appropriate configuration from the drop-down list displayed in Figure 27.

The ReadMe.txt file in the SDK directory provides descriptions of the drop-down list contents.

Note: The selected configuration should match the EVB configuration as well as the configuration selected in 
Figure 16.
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FIGURE 27: MPLAB X IDE CONFIGURATION SELECTION

20. Click the Clean and Build Project button (hammer and brush icon) to build the project.
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If the project is built successfully, the debug message should display “BUILD SUCCESSFUL”, as displayed in 
Figure 28.

FIGURE 28: MPLAB X IDE CLEAN AND BUILD PROJECT

21. Connect the PICKit3 debugger to the EVB-LAN9252-HBI evaluation board.

22. Click the Make and Program Device button (rectangular box with downward facing arrow icon), as displayed in 
Figure 29.
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This will program the PIC microcontroller.

FIGURE 29: MPLAB X IDE MAKE AND PROGRAM DEVICE

The ESI file (.XML) will be generated from the SSC tool in the same directory as the C source files. This ESI file 
has to be programmed into LAN9252 EEPROM using the TwinCAT. Once the EEPROM programming is com-
plete, the controller state changes to “OP” as displayed in Figure 30.
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Note: Refer to EVB-LAN9252-HBI Software Quick Start Guide (http://ww1.microchip.com/downloads/en/Device-
Doc/50002425A.pdf) for further details.

FIGURE 30: TWINCAT MASTER VIEW
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APPENDIX A:  APPLICATION NOTE REVISION HISTORY

TABLE A-1: REVISION HISTORY 

Revision Level & Date Section/Figure/Entry Correction

DS00001916B (01-29-16) Throughout document. Updated all instances of EtherCAT so only title and 
first instance has the registered trademark symbol. 

Trademarks on page 25. Updated entire page.

 Introduction on page 1 Updated last paragraph.

 Software Requirements on 
page 2

Updated second bulleted item.

Table 1, “Terms and Abbrevi-
ations,” on page 2

Corrected definition of EVB.

 SDK Directory Structure on 
page 3

Updated section.

FIGURE 2: LAN9252-
PIC32_SDK_V1.3 Folder 
Contents on page 3

Updated image.

FIGURE 3: ESI Files Folder 
Contents on page 3

Updated image.

 Building a Full-Featured 
EtherCAT Application on 
page 4

Updated title to include hyphen. Updated section.

FIGURE 4: SSC Folder Con-
tents on page 4

Updated image.

 SSC Tool on page 8 Updated section.

FIGURE 14: SSC Tool New 
Project on page 9

Updated image.

FIGURE 15: SSC Tool New 
Project Import on page 9

Updated image.

FIGURE 16: SSC Tool New 
Project Custom on page 10

Updated image.

FIGURE 17: SSC Tool 
External File Confirmation 
on page 10

Updated image.

FIGURE 18: SSC Tool 
9252_HW.c Confirmation on 
page 11

Updated image.

FIGURE 19: SSC Tool 
9252_HW.c Selection on 
page 11

Updated image.

FIGURE 20: SSC Tool New 
Project Created on page 12

Updated image.
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DS00001916B (01-29-16) 
[continued]

FIGURE 21: SSC Tool Cre-
ate New Slave Files on 
page 13

Updated image.

FIGURE 22: SSC Tool File 
Creation Dialog on page 13

Updated image.

FIGURE 23: New Slave 
Files on page 14

Updated image.

FIGURE 24: MPLAB X IDE 
on page 15

Updated image.

FIGURE 25: MPLAB X IDE 
Open Project on page 16

Updated image.

FIGURE 26: MPLAB X IDE 
Project Loaded on page 17

Updated image.

FIGURE 27: MPLAB X IDE 
Configuration Selection on 
page 18

Updated image.

FIGURE 28: MPLAB X IDE 
Clean and Build Project on 
page 19

Updated image.

FIGURE 29: MPLAB X IDE 
Make and Program Device 
on page 20

Updated image.

DS00001916A (04-10-15) Initial release.

TABLE A-1: REVISION HISTORY (CONTINUED)

Revision Level & Date Section/Figure/Entry Correction
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THE MICROCHIP WEB SITE

Microchip provides online support via our WWW site at www.microchip.com. This web site is used as a means to make 
files and information easily available to customers. Accessible by using your favorite Internet browser, the web site 
contains the following information:

• Product Support – Data sheets and errata, application notes and sample programs, design resources, user’s 
guides and hardware support documents, latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQ), technical support requests, online discussion 
groups, Microchip consultant program member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip press releases, listing of 
seminars and events, listings of Microchip sales offices, distributors and factory representatives

CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip products. Subscribers will receive 
e-mail notification whenever there are changes, updates, revisions or errata related to a specified product family or 
development tool of interest.

To register, access the Microchip web site at www.microchip.com. Under “Support”, click on “Customer Change Notifi-
cation” and follow the registration instructions.

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support

Customers should contact their distributor, representative or Field Application Engineer (FAE) for support. Local sales 
offices are also available to help customers. A listing of sales offices and locations is included in the back of this 
document.

Technical support is available through the web site at: http://microchip.com/support

http://www.microchip.com
http://www.microchip.com
http://www.microchip.com
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Information contained in this publication regarding device applications and the like is provided only for your convenience and may be 
superseded by updates. It is your responsibility to ensure that your application meets with your specifications. MICROCHIP MAKES NO 
REPRESENTATIONS OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY OR 
OTHERWISE, RELATED TO THE INFORMATION, INCLUDING BUT NOT LIMITED TO ITS CONDITION, QUALITY, PERFORMANCE, 
MERCHANTABILITY OR FITNESS FOR PURPOSE. Microchip disclaims all liability arising from this information and its use. Use of Micro-
chip devices in life support and/or safety applications is entirely at the buyer’s risk, and the buyer agrees to defend, indemnify and hold 
harmless Microchip from any and all damages, claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or 
otherwise, under any Microchip intellectual property rights unless otherwise stated.

Trademarks

The Microchip name and logo, the Microchip logo, AnyRate, dsPIC, FlashFlex, flexPWR, Heldo, JukeBlox, KeeLoq, KeeLoq logo, 
Kleer, LANCheck, LINK MD, MediaLB, MOST, MOST logo, MPLAB, OptoLyzer, PIC, PICSTART, PIC32 logo, RightTouch, SpyNIC, 
SST, SST Logo, SuperFlash and UNI/O are registered trademarks of Microchip Technology Incorporated in the U.S.A. and other 
countries.

ClockWorks, The Embedded Control Solutions Company, ETHERSYNCH, Hyper Speed Control, HyperLight Load, IntelliMOS, 
mTouch, Precision Edge, and QUIET-WIRE are registered trademarks of Microchip Technology Incorporated in the U.S.A.

Analog-for-the-Digital Age, Any Capacitor, AnyIn, AnyOut, BodyCom, chipKIT, chipKIT logo, CodeGuard, dsPICDEM, dsPICDEM.net, 
Dynamic Average Matching, DAM, ECAN, EtherGREEN, In-Circuit Serial Programming, ICSP, Inter-Chip Connectivity, JitterBlocker, 
KleerNet, KleerNet logo, MiWi, motorBench, MPASM, MPF, MPLAB Certified logo, MPLIB, MPLINK, MultiTRAK, NetDetach, 
Omniscient Code Generation, PICDEM, PICDEM.net, PICkit, PICtail, PureSilicon, RightTouch logo, REAL ICE, Ripple Blocker, Serial 
Quad I/O, SQI, SuperSwitcher, SuperSwitcher II, Total Endurance, TSHARC, USBCheck, VariSense, ViewSpan, WiperLock, Wireless 
DNA, and ZENA are trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

Silicon Storage Technology is a registered trademark of Microchip Technology Inc. in other countries.

GestIC is a registered trademarks of Microchip Technology Germany II GmbH & Co. KG, a subsidiary of Microchip Technology Inc., in 
other countries. 

All other trademarks mentioned herein are property of their respective companies.

© 2015-2016, Microchip Technology Incorporated, Printed in the U.S.A., All Rights Reserved. 

ISBN: 978-1-5224-0248-0

Note the following details of the code protection feature on Microchip devices:

• Microchip products meet the specification contained in their particular Microchip Data Sheet.

• Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the 
intended manner and under normal conditions.

• There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our 
knowledge, require using the Microchip products in a manner outside the operating specifications contained in Microchip’s Data 
Sheets. Most likely, the person doing so is engaged in theft of intellectual property.

• Microchip is willing to work with the customer who is concerned about the integrity of their code.

• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not 
mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our 
products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts 
allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.

Microchip received ISO/TS-16949:2009 certification for its worldwide 
headquarters, design and wafer fabrication facilities in Chandler and 
Tempe, Arizona; Gresham, Oregon and design centers in California 
and India. The Company’s quality system processes and procedures 
are for its PIC® MCUs and dsPIC® DSCs, KEELOQ® code hopping 
devices, Serial EEPROMs, microperipherals, nonvolatile memory and 
analog products. In addition, Microchip’s quality system for the design 
and manufacture of development systems is ISO 9001:2000 certified.

QUALITY	MANAGEMENT		SYSTEM	
CERTIFIED	BY	DNV	

== ISO/TS	16949	==	
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AMERICAS
Corporate Office
2355 West Chandler Blvd.
Chandler, AZ 85224-6199
Tel: 480-792-7200 
Fax: 480-792-7277
Technical Support: 
http://www.microchip.com/
support
Web Address: 
www.microchip.com

Atlanta
Duluth, GA 
Tel: 678-957-9614 
Fax: 678-957-1455

Austin, TX
Tel: 512-257-3370 

Boston
Westborough, MA 
Tel: 774-760-0087 
Fax: 774-760-0088

Chicago
Itasca, IL 
Tel: 630-285-0071 
Fax: 630-285-0075

Cleveland
Independence, OH 
Tel: 216-447-0464 
Fax: 216-447-0643

Dallas
Addison, TX 
Tel: 972-818-7423 
Fax: 972-818-2924

Detroit
Novi, MI 
Tel: 248-848-4000

Houston, TX 
Tel: 281-894-5983

Indianapolis
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Tel: 317-773-8323
Fax: 317-773-5453

Los Angeles
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Tel: 949-462-9523 
Fax: 949-462-9608

New York, NY 
Tel: 631-435-6000

San Jose, CA 
Tel: 408-735-9110

Canada - Toronto
Tel: 905-673-0699 
Fax: 905-673-6509

ASIA/PACIFIC
Asia Pacific Office
Suites 3707-14, 37th Floor
Tower 6, The Gateway
Harbour City, Kowloon

Hong Kong
Tel: 852-2943-5100
Fax: 852-2401-3431

Australia - Sydney
Tel: 61-2-9868-6733
Fax: 61-2-9868-6755

China - Beijing
Tel: 86-10-8569-7000 
Fax: 86-10-8528-2104

China - Chengdu
Tel: 86-28-8665-5511
Fax: 86-28-8665-7889

China - Chongqing
Tel: 86-23-8980-9588
Fax: 86-23-8980-9500

China - Dongguan
Tel: 86-769-8702-9880 

China - Hangzhou
Tel: 86-571-8792-8115 
Fax: 86-571-8792-8116

China - Hong Kong SAR
Tel: 852-2943-5100 
Fax: 852-2401-3431

China - Nanjing
Tel: 86-25-8473-2460
Fax: 86-25-8473-2470

China - Qingdao
Tel: 86-532-8502-7355
Fax: 86-532-8502-7205

China - Shanghai
Tel: 86-21-5407-5533 
Fax: 86-21-5407-5066

China - Shenyang
Tel: 86-24-2334-2829
Fax: 86-24-2334-2393

China - Shenzhen
Tel: 86-755-8864-2200 
Fax: 86-755-8203-1760

China - Wuhan
Tel: 86-27-5980-5300
Fax: 86-27-5980-5118

China - Xian
Tel: 86-29-8833-7252
Fax: 86-29-8833-7256

ASIA/PACIFIC
China - Xiamen
Tel: 86-592-2388138 
Fax: 86-592-2388130

China - Zhuhai
Tel: 86-756-3210040 
Fax: 86-756-3210049

India - Bangalore
Tel: 91-80-3090-4444 
Fax: 91-80-3090-4123

India - New Delhi
Tel: 91-11-4160-8631
Fax: 91-11-4160-8632

India - Pune
Tel: 91-20-3019-1500

Japan - Osaka
Tel: 81-6-6152-7160 
Fax: 81-6-6152-9310

Japan - Tokyo
Tel: 81-3-6880- 3770 
Fax: 81-3-6880-3771

Korea - Daegu
Tel: 82-53-744-4301
Fax: 82-53-744-4302

Korea - Seoul
Tel: 82-2-554-7200
Fax: 82-2-558-5932 or 
82-2-558-5934

Malaysia - Kuala Lumpur
Tel: 60-3-6201-9857
Fax: 60-3-6201-9859

Malaysia - Penang
Tel: 60-4-227-8870
Fax: 60-4-227-4068

Philippines - Manila
Tel: 63-2-634-9065
Fax: 63-2-634-9069

Singapore
Tel: 65-6334-8870
Fax: 65-6334-8850

Taiwan - Hsin Chu
Tel: 886-3-5778-366
Fax: 886-3-5770-955

Taiwan - Kaohsiung
Tel: 886-7-213-7828

Taiwan - Taipei
Tel: 886-2-2508-8600 
Fax: 886-2-2508-0102

Thailand - Bangkok
Tel: 66-2-694-1351
Fax: 66-2-694-1350
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Austria - Wels
Tel: 43-7242-2244-39
Fax: 43-7242-2244-393

Denmark - Copenhagen
Tel: 45-4450-2828 
Fax: 45-4485-2829

France - Paris
Tel: 33-1-69-53-63-20 
Fax: 33-1-69-30-90-79

Germany - Dusseldorf
Tel: 49-2129-3766400

Germany - Karlsruhe
Tel: 49-721-625370

Germany - Munich
Tel: 49-89-627-144-0 
Fax: 49-89-627-144-44

Italy - Milan 
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